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Stock Prospector
Quick Start Guide

What Is Stock Screening?

Screening is a powerful tool used to help investors find companies worthy of study. As
with aprospector’ s search for gold or gems, it is essential that you know what you're
looking for. Define your objectives clearly, as they will direct your search.

Always keep in mind that screening is only a starting point and must be followed by solid
analysis of the companies unearthed

Specifications

Stock Prospector is designed for the Microsoft Windows Operating systems 2000, XP, or
Vista. The following are minimum system requirements:

- 32 Mb RAM

- 45 Mb drive space (including a database of approximately 7,000 companies and
industry averages)

- Intel Pentium 200 Mhz or equivalent
- A color display with 800x600 resolution and a mouse are also required.

Installing Stock Prospector

Toingtal Stock Prospector from aCD, start Windows and then place the Stock Pros-
pector CD in your CD-ROM drive. The Auto Start installation should automatically run,
and you may just follow the on-screen instructions to install.

Toingtal Stock Prospector from the downloadabl e installation file, simply double-click
the ingtaller and follow the prompts until finished.

Registering Stock Prospector

After installing your new Stock Praospector, please take a moment to register your pro-
gram.

As aRegistered User of Stock Prospector, you will receive the following benefits:

Technical Support: Free technical support from ICLUBcentral for ninety days
following the purchase of the software.

Updates: Free software updates for Stock Prospector are downloaded and in-
stalled automatically.

Stock Prospector Quick Start Guide - 1



Register your copy of Stock Prospector as you install the program. Simply follow thein-
structions on the screen to do so.

Running Stock Prospector

Onceinstalled, Stock Prospector will have been set up to alow you to run the program.
To run Stock Prospector, double-click the icon on your desktop, or click Start and select
Programs. From the list of Program Groups, find and select the | CL UBcentral group and
click the Stock Prospector icon. Thiswill start the program.

Importing data

Theinitid database contains approximately 1,000 companies. Thisis only a starting da-
tabase and is meant to be used to help you learn the program using the L ab exercises lat-
er in the manual.

To screen for stocks, you' |l need to bring data relating to each stock into the program.
There are two sources of data that you can use with the program.

One source of dataisfrom StockCentral.com. The datafiles offered by StockCentral
provide ten years of historical company histories for all U.S. public companies based on
source data provided by Morningstar. Data for Stock Prospector isincluded in the annual
subscription to the site, which is available for anominal annual subscription. A free 45-
day trial is available. For more information, please call 1-877-33-ICLUB or visit:

http://www.stockcentral .com

BetterInvesting' s S& P Data Service also provides data that may also be used in the pro-
gram. Dataisincluded in the organization’s annua membership fee and is provided by
Standard & Poor’s. For more information on Betterinvesting and their data services, visit:

http://www.betterinvesting.org

Importing data from data provider

Iﬁ] Use the Import button to download and transfer data directly from your selected
& data service. Thisisthe fastest and easiest way to import datainto Stock Pros-
pector.

You can aso click on File> Import Datafiles > Download Datafiles.

Once you have selected this option, you will be presented with a screen asking for your
sel ected data subscription and your login name and password. Entered your login and
password, click on *Apply Changes' to save for future use.

Import

Once you have entered your data subscription information (login and password), review
the date of the last import of data, and select * Start import’ to download the current data
as needed.

Y ou may be prompted to connect to the Internet if you use a modem and telephone dial-
up connection. Depending on your internet connection speed, after you select * Start im-
port’, you will need to wait between two and five minutes for a high speed connection
such as a cable modem or DSL or between twenty minutes and one hour with slow con-
nection speeds such asadialup ISP.

Once the processis complete, you should see a message that says ‘ Import complete.’
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Screening for Beginners

Getting Started Quickly

Thetwo labsincluded in the online manual may be used astutorials to highlight sections
of the program that will be used most often.

Lab 1 dealswith the Wizard and will show you how quickly you can screen for compa-
niesto study. L ab 2 takes you to a more advanced level to show how to edit criteriaand
areport in preparation for fully customized searches.

Prospector Wizard

The Prospector Wizard guides you step-by-step through finding companies with spe-
cific characterigtics.

Pre-defined Screen

The easiest and quickest choice isto select from previously defined reports.

Click ‘Next’ to perform the screening function you choose. Then, choose how you
would like the results sorted, and they will be displayed in the Company Grid.

Stock Prospector includes several predefined reports and screening criteria
Better Investing 1 — Searches for companies that “fit” Betterlnvesting standards.
Better I nvesting 2 — Phil Keating' s Betterinvesting Growth Screen methods.

ICLUB Growth and Quality — Searches for companies with high quality and
consistently better historical growth than their industry averages.

The Growth, Quality, Value, and Safety screens are smply the Better | nvest-
ing 1 screen biased towards companies with high growth, quality, value, and
safety characteristics, respectively.

Custom Wizard

The Custom Wizard enables you to prioritize the characteristics of growth, quality, val-
ue, and safety when searching for companies. Criteriaand reports will be generated on
these items. The results can be scrutinized, saved, and used to help you learn how to
build fully customized reports.

In the Custom Wizard window, select the characteristics for your search, using the slide
controls to prioritize each characteristic you seek. Zero denotes minimal importance and
five the most importance. (Be aware that selecting 5 for each characteristic may yield
very few or no companiesin the screen.) Y ou must set at least one dider to activate the
Custom Wizard.

The Custom Wizard will ater the nature of the criteria and the report for screening
your database of companies, according to your settings. If you change your settings, the
number of companies screened will change. To view results, click ‘Finish’ and save
when prompted. Then, retrieve the saved criteria/report by clicking the * Report’ icon and
displaying your UR (User Report) list.

Sorting

The next screen alows you to sort the resulting set of companies. Select adataitem
from the list and choose an ascending or descending sort on that selection.
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Viewing the Results

Once the criteria and report are defined, you can complete the screening process with the
next button. In afew seconds, the results will be displayed in the Company Grid.

To look at details of companies that have been selected by your screen, highlight the
company and click the View Company icon on the toolbar, or double-click on the com-
pany.

You can aso right click on a highlighted company and select “ Open <Company> SSG
file” from the pop-up menu. This provides enhanced ability to send SSG data to any
stock analysis program that can read a*.SSG datafile. Y ou must have a connection to
the Internet so Stock Prospector can request the data from your data provider’'s website
and alow the analysis program to open and use it immediately.

Customer Support
Check herefirst!

Select ‘Help’ from the Main Menu, then pick ‘Help contents’ or ‘ Sear ch for
help on...".

Check the User’s Guide on your Stock Prospector CD.
Review the README file located in the program directory.

The fastest way to get your Stock Prospector questions answered isto visit the ICLUB-
central Support web site (www.iclub.com/support), which includes solutions to common
problems, including questions about software installation and operation.

Another great resource is our email newsdletter, which frequently includes information on
mergers and spin-offs. Subscribe yourself at:
http://www.iclub.com/clubs/news etter.asp

If you can’'t find what you’ re looking for on our website, remember that your Stock
Prospector purchase entitles you to ninety days of Customer Support. For aquick re-
sponse, just fill out our online support form (www.iclub.com/support/), and one of our
Support Specialists will reply to your question quickly. Remember to have in hand:

1. Precise wording of any error messages displayed on screen.

2. Your Stock Prospector version number (from Help > About Stock Prospector),
the version of Windows you are using; the make, model and amount of memory
(RAM) on your computer; the make and model of the printer if you have a printing
guestion.

3. Your Stock Prospector serial number and approximate date of purchase.
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Advanced Operations Reference

Customized Screening Criteria

The advanced operation of Stock Prospector permits full customization of the search
process. The main thrust of this activity occursin two parts: the Screen Window and the
Report Window.

Screen Window

Defining Your Own Criteria

To define anew criteriaexpression, click the Criteriaicon. The Criteria Selection
window opens with 2 panes.

The l€eft side contains theicons for Pre-Defined Criteria (PDC) and User Criteria
(UC). Click onaniconto view individual criteria statements pertaining to theicon.
Double-click on a statement to add it to the report item list. Continue until all the state-
ments you wish to use are included.

Basically, criteria statements are made up of 3 parts: areport item, an operator, and a
value. The pane on the right contains the 3 columns. If you don’t see all 3, make the
window wider or use the scroll bars. Y our criteria choices should be based on your over-
all objective for your search.

Y ou may select report items from the drop-down list in the right pane (see the Report
Item column). Thislist contains al criteriaitems, in alphabetical order.

In the Criteria column, click with the right mouse button and select Operators. From the
list provided, select the operator for your criteria statement. The operator can also be
typed in from the keyboard.

Lastly, enter avalue. Use adecimal fraction for a percentage (.15 for 15%, for example).

For certain report items (exchange, industry, etc.) you can select from alist by clicking
with the right mouse button.

Y ou can add additional criteria statements to complete the expression.

Refer to the chartsincluded in this guide or to the Appendix of the online manual for
more information on the specifics of operators, expressions etc.
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Saving User-defined Screening Criteria

Once you have created your screening criteria, the list can be saved with an appropriate
name. This new criteria now forms part of the user-defined criteria (with a UC icon) and
can be used at a future date to compare results using new data. Aswell, the user-defined
criteria can be used as a starting point for generating other criterialists.

When saving a user-defined screening criterialist, Stock Prospector will also generate
and save aUser Defined Report Item list with the same name. The report Item list will
contain the Company Name and the items used in your screening criteria. Y ou can later
modify and re-save that report Item list as needed to suit your preferences. See “ Creating
and saving user-defined reports’ below.

Thereis no limit to the number of screening criteria groups that you can define. We sug-
gest that you define an initial screening criterialist that particularly suits your style of
investing and your objectives. Then use this with minor variations to implement or test
other possibilities. It is best to work from a criterialist that you know well and use that
knowledge to learn more about defining other criteria.

Pro Mode

The Pro M ode check box expands the customization of criteria statements to include
very complex criteria expressions. As customized criteria can be very detailed, they can
be prone to syntax errors such asincorrect placement of commas, quotes, brackets, etc.

Complex expressions are under user control and knowledge. Please refer to one of the
many SQL books available on this subject. ICLUBcentral Support does not resolve er-
rors due to user-built expressions.

Importing Pre-Defined Query Files (QDF files)

Stock Prospector version 2.7 includes a number of pre-defined queries (QDF files) that
can beimported and used, modified, or saved to the database. These sample queries are
located in the Queries folder within the Stock Praospector program folder. Select File >
Import Query from File to load these saved queries. Imported queries are not automat-
ically saved to the Stock Prospector database. To save an imported query open the
Screening Criteria window and select Save.

Report Window

Stock Prospector automatically fillsin thelist of report items (columns) based on the
selected screening criteria. (New Reports only) To customize areport, click the Define
Report icon. The window contains two panes, with the Item Groups (IG) and Report
Lists on the left.

Y our objectiveisto select meaningful items for your custom report. Do this by clicking
items from the pane on the left and adding them to the new report on the right.

Click the Item Group (I G) iconsto expand and show individual items. Click a second
time to compressthe list.

Use the scroll bar or resize the window to view all items on thelist.

Theiconsin the left pane are defined below. These identify the Item Group (IG), Pre-
vioudy Defined Report (PDR), and User Report (UR). The ALL icon contains all the
availableitemsin aphabetical order.
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The user should note that the number of items used in the report directly affects the time
to search for companies and calculate weights.

Report Icons

The following icons on the left pane show the selection of reports and individual items
to build customized reports.

IG (Item Group) and ALL (database items) are lists of items provided to help with the
definition of customized reports.

Altering a Report

It is easiest and fastest to start with a previously defined report and alter it to suit your
new search.

Start by selecting a pre-defined or user report. Highlight the report and click Add to add
it to ablank list on the right pane. The selected report can then be edited by adding or
removing items as desired.

To change the item order of your report, highlight the item and click the up/down button
to move it to the new location. Once altered, you may choose to save the new report with
its own unique name and description.

The numeral (0 to 5) on theright side of the item indicates the default weight for that
item or group (N/A shows that an item does not have aweight rating).

- Item Group — All database items are divided into related groups: other, growth,
value, quality, safety, projection, proxy, and trend. Item Groups are not reports.

- Pre-Defined Reports — These are the beginner reports provided by Stock Pros-
pector: BetterInvestingl, BetterInvesting2, | CLUB Growth and Quality,
Growth, Value, Quality, and Safety.

- User Reports— These are reports that you defined and saved. An example of
thisisthe Dow Jones report.

- All Database Items— Y ou can select from thislist in alphabetical order. Thisis
not areport.

- User Defined Item — These are items that you have defined using Cr eate items,
in the Report window.

Creating a New Report

A new report is created by selecting individua items from any of the item groups on the
left pane and building your custom report on the right.

Highlight the item in the reportg/items list and then click Add. Continue in this way to
list dl the items you want in your new report. Be sure to use only items that are mea-
ningful to you and that tell you something about a company. Items should focus your
search objectives for the characteristics of the companies you want to find.

To change the position of an item in the list, highlight the item and click the up/down
buttons to move it to the desired place.

To remove an item from the list, highlight it and click the Remove button.

Y ou can add the contents of a group by highlighting the group icon on the left pane and
then clicking Add.
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Saving User-defined Reports

Once you have modified areport, it can be saved with an appropriate name. This new
report now forms part of the user-defined reports (with a UR icon) and can be used at a
future date to compare results using new data. Aswell, the user-defined report can be
used as a starting point for generating other reports.

Thereis no limit to the number of reports that you can define. We suggest that you de-
fineaninitial report that particularly suits your style of investing and your objectives.
Then use this with minor variations to implement or test other possibilities. It is best to
work from areport that you know well and use that knowledge to learn more about de-
fining reports.
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Data Items

Alphabetical Sort (All Data Items)

# Item Name Description

Compares current price to 52 week high price. Formula: Current Price -
52W Hi Price) / 52W Hi Price (Will always be <= 0). Price being close
to the 52 week high suggests a positive trend. This may show the compa-
ny to be overpriced.

1 % From 52W Hi

Compares current price to 52 week low price. Formula: Current Price -
2 % From 52W Low 52W Low Price) / 52W Low Price (Will always be <= 0). Price being
near the 52 week low suggests a negative trend.

52W Hi Price Highest share price reached during the last 52 weeks.

52W Low Price Lowest share price during the past 52 weeks.

Anaysts consensus EPS. Analysts' forecast of current year's (fiscal

5 |ACEIYrProjEPS | vV EPS. See'Proj 1 Yr EPSGr .

Analysts' expectations for EPS extrapolated to calculate EPS 5 yearsin
6 Anayst 5Yr EPS the future. Formula: ACE 1Yr Proj EPS* (1+ Proj5YrEPSGr) " 4.
See'Proj 5 YrEPSGr'.

7 Assets - Millions Current assets. | ndicates company size by measuring its assets.

8 Avg Debt/Equity Average debt to equity over the last 5 years.

Formula: (Avg 5Yr High PE + Avg 5Yr low PE) / 2. Average

9 Avg PE Price/Earnings ration for the last 5 years.

Average high PE for last 5 years. Calculated from yearly information

10 Avg 5Yr High PE from OPS data.

Average low PE for last 5 years. Calculated from yearly information

11 Avg 5Yr Low PE from OPS data.

Average 5-year PTI. Simple average cal culated from OPS data. Pre-tax

2 AvgSYTPTI Income on Sales (i.e. profitability). See Trend PTI" .

Average 5-year ROE. Simple average calculated from OPS data. Return

13 | Avg5YrROE on Common Equity. See 'Trend ROE' .

Historical average dividend yield. Calculated using the last 5 years' an-

14 AvgDiv Yield nual data from OPS data.
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Measure of price volatility in relation to the market. Could be misleading

5 Beta for fast-growing companies.
Book value per share growth (common equity / number of shares).
16 Book Value Gr Growth in book value for the number of years available. Regulated in-
dustries (utilities) pay out a fixed amount based on their assets. Book
Valueis an indication of assets.
Lowest third of the price range based on equal (33/33/33%) divisions
1 Buy Below between Proxy Hi Pr and Proxy Low Pr .
18 Captlztion - Mil- Capitalization = Number of shares* current price. Indication of the com-
lions pany size by market valuation.
Growth in cash flow for number of years of data available. Can be used
19 Cash Flow Gr to confirm EPS growth. In some industries (resources, cable, etc.) cash
flow is a better indicator than EPS.
20 CashFlow / Share Cash flow per share. As provided by OPS data.
21 (1:8{2 Equity R2 Common equity consistency over the last 10 years.
22 Company Name Company name.
23 Current Div Current dividend.
24 Current EPS Current earnings per share — Total of last 4 quarters of reported earnings.
5 Current PE Current Price/Earnings ratio as available from OPS data. EPS (earnings)
isusualy for 2 reported quarters plus 2 anticipated quarters.
26 Current Price Current share price for the date indicated in 'Date Info' .
. Current ratio. Current assets/ current liabilities. Measure of liquidity.
21 Current Ratio Ratios of 2 or higher are generally considered good.
8 Cur Div Yidd Current dividend yield. For those interested in income from their invest-
ment.
29 Currency Name Defl ned when importing OPS data. Applicable only for dealing with for-
eign stocks.
30 Date Info Date when OPS data was generated.
31 Debt / Capital As 'Debt / Equity' , except using the working capital.
3 Debt / Equity pebt tq equity rano. Measure oflllopg term debt for company. For most
industries 30% is acceptable. Utilities typically have high ratios.
) Numerical figure derived from trend of 'Debt / Equity’ . The numerical
33 il?]ebt / Bquity Rat- equivaent of 'Debt / Equity' , which varies from 6 to 0, where ++ = 6 and
9 -- = 0. For thisrating, 4 or lower is best.
. Growth in dividends for the number of years of data available. For those
34 Div Gr . L .
interested in income from investments.
Dividend payout ratio. 5 yr average of ratio for dividends/ EPS. An indi-
35 Div Payout cator of safety of dividends paid. For most industries look for 60% or
less. Exceptions are utilities.
36 Dividend R2 10Yr Dividend consistency over the last 10 years.
If True, it indicates that 'ACE 1Yr Proj EPS was provided from the data
37 EPSEst Flag 1Yr provider. If False, it was calculated by Prospector based on internal for-
mula.
If True, it indicatesthat 'Proj 5 Yr EPS Gr' was provided from the data
38 EPS Est Flag 5Yr provider. If False, it was calculated by Prospector based on internal for-
mula.
EPS consistency. R? (or R squared) is the coefficient of correlation from
39 EPS R2 10yr the calculation of 'Hist 10Yr EPS Gr' . Variesfrom 1 to O where 1 isthe

most consistent and desirable.
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40 EPS R2 3yr EPS consistency over the last 3 years.

41 EPS R2 5yr EPS consistency over the last 5 years.

42 EPS Rank - DB Compares short term growth to the average short term growth of the da-
tabase.

43 EPS Rank - Indus _Compareﬁ short term EPS growth to the average short term growth of the
industry.

. - -

a4 EPS Trend Difference in % change EPS (last 4 quarters) to weighted growth for the
company.

45 EPS Trend — DB Compares 'EPS Trend' of the company to the trends of the database.

46 EPS Trend — Indus Compares 'EPS Trend' of the company to the trends of the industry.

47 Exchange Trading exchange.

8 Exchange Rate D_efl ned when importing OPS data. Applicable only for dealing with for-
eign stocks.
Growth in average share price for the number of years available, based

49 Hist Share Gr on yearly data. Comparing this to EPS growth, can suggest whether PE is
expanding or contracting. This can indicate whether a stock is getting
overpriced.
Historical 10-year growth for EPS. Uses aleast-squares calculation to

50 Hist 10Yr EPS Gr determine EPS growth. Long term growth rate. Use 'EPS R2 10yr' to in-
dicate consistency in results.
Historical 10-year growth for revenues — Calculation uses the yearly data

51 Hist 10Yr Rev Gr and a least-squares calculation to determine past growth. Long term
growth rate. Use 'Rev R2 10Yr' to indicate consistency in results.
Historical 1-year EPS growth. Use with 'Hist 10Yr EPS Gr', 'Hist 5Yr

52 Hist 1Yr EPS Gr EPS Gr' and 'Hist 3Yr EPS Gr' to indicate trend of growth (increasing or
decreasing).

53 Hist 1Yr Price Gr Price growth based on Monthly data.
Historical 1-year revenue growth. Use with Items 'Hist 10Yr Rev Gr',

54 Hist 1Yr Rev Gr 'Hist 5Yr Rev Gr', and 'Hist 3Yr Rev Gr' to indicate trend of growth (in-
creasing or decreasing).
Historical 3-year EPS growth. Use with 'Hist 10Yr EPS Gr' and 'Hist 5Yr

55 Hist 3Yr EPS Gr EPS Gr' to indicate trend of growth (increasing or decreasing). May also
be used with 'EPS R2 3Yr' to indicate consistency in resullts.

56 Hist 3Yr Price Gr Price growth based on Monthly data.
Historical 3-year revenue growth. Use with 'Hist 10Yr REV Gr' and 'Hist

57 Hist 3Yr Rev Gr 5Yr REV Gr' to indicate trend of growth (increasing or decreasing). May
also be used with 'Rev R2 3Y'r' to indicate consistency in results.
Historical 5-year growth for EPS. As provided in OPS data. Use with

58 Hist 5Yr EPS Gr ‘Hist 10Yr EPS Gr' to indicate trend of growth (increasing or decreasing).
May also be used with 'EPS R2 5Yr' to indicate consistency in resullts.

59 Hist 5Yr Price Gr Price growth based on Monthly data.
Historical 5-year revenue growth. Use with 'Hist 10Yr Rev Gr' to indi-

60 Hist 5Yr Rev Gr cate trend of growth (increasing or decreasing). May also be used with
'Rev R2 5Yr' to indicate consistency in results.
Formula: Avg 5Yr ROE * (1 — Div Payout) . The growth rate of retained

61 Implied Gr earnings. An indication of future growth can be made from implied
growth.

62 Industry Thisisindustry name. To screen by this use [Industry] = and select name

fromthelist provided.
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63 Inside Ownership Percent ownership by directors and management of the company.
64 Ingtitutional Hold- Percent ownership by pension and mutual funds and professional manag-
ings ers.
65 Int Coverage Inter_eﬂ coverage. Th_e ratio of pre-tax income to interest paid on all debt.
A ratio of 3 or larger is good.
66 Inventory Turnover | Based on yearly sales and the latest inventory.
67 Last Full Yr Ia:tsat-year of data, the fiscal year. Thisisthe year of the last full year of
Latest 4 quarters EPS growth. Growth of moving yearly EPS compared
68 Last 4Q EPS Gr to the same period ayear earlier. Current growth rate. Compare this with
thelast 1 or 3 year growth to determine consistency.
Latest 4 quarters revenue growth. Growth of moving 4 quarter revenues
69 Last 4Q Rev Gr compared to the similar period ayear earlier. Current growth rate. Com-
pare thiswith the last 1 or 3 year growth to determine consistency.
70 Last Quarter Date Date of the last reported quarter in the OPS data.
71 |’\II (())nihares - Mil- Number of shares. Measure of possible liquidity of company.
72 Num Yrs of Data Number of years of sales data available for the company.
The number of years for yearly accumulated EPS to equal current price.
73 Payback Generally between 6 and 10 - the lower the better. However, be suspi-
cious of very low numbers.
74 PE / Avg ROE Price qf Profltablllty. Formula: Current PE / Avg 5Yr ROE . Vauesless
than 1 indicate good value.
. Current PE divided by Historical EPS growth. As provided in OPS data
£ PE/Hist EPS Gr or isequal to: Current PE / Hist 10Yr EPS Gr - (Peter Lynch’s formula).
. Similar to 'PE / Hist EPS Gr' but using projected EPS. Commonly re-
6 PE/ Proj EPS Gr ferred to as the PEG Ratio.
77 Price / Book Value Cyrrtlent price d|V|decli by latest reported book value (per share). Review
with '‘Book Vaue Gr' .
. Price to cash flow per share. Current price divided by the latest reported
78 | Price/CashFlow | oy flow figure. Review with ‘Cash Flow Gr' .
Current price divided by the latest sales per share figure. An indication of
79 Price/ Sales value for fast growing companies - not susceptible to accounting methods
(EPS) and depreciation (BookV1).
80 Price App ﬁti)rl:r)]rg')ounded (annualized) appreciation from ‘Current Price' to the 'Proxy
81 Pricein Zone The % that the 'Current Price' is above the 'Proxy Low Pr' . Zero isat the
'‘Proxy Low Pr'. 100% is at the 'Proxy Hi Pr'.
. Typically the date of the last share price update, ‘Current Price' , or when
82 Price Last Updated OPS data was first generated.
83 Price Rank - DB Compares short term changes to the average short term changes of the
database.
84 Price Rank - Indus Cor_npareﬁ short term price changes to the average short term changes of
the industry.
- P - -
85 Price Trend Difference in % price change (last 12 months) in comparison to the 5
year change.
86 Price Trend - DB Compares 'Price Trend' of the company to the trends of the database.
87 Price Trend - Indus | Compares 'Price Trend' of the company to the trends of the industry.
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88

Price Variance

Statistical variation of yearly prices over the past 10 years.

Calculated only during updates from OPS data. This compares previous

89 Proj EPS Revision ACE EPS, 'ACE 1Yr Proj EPS' to the current value and reports any
changes.
90 Proj 1 Yr EPS Gr Expected EPS growth calculated from 'ACE 1Yr Proj EPS'.
. Analysts' consensus EPS growth expected over the next 5 years. See
91 Proj 5 Yr EPS Gr ‘Analyst 5Yr EPS .
92 Proxy Hi Pr Expected high price 5 yearsin the future.
Projected low price over the next 5 years based on a statistical assess-
93 Proxy Low Pr : e .
ment of price variation over the previous 5 years.
o PTI Ratin Numerica figure derived from "Trend PTI' . The numerical equivalent of
9 ‘Trend PTI' , which varies from 6 to O, where ++ =6 and -- = 0.
Growth of quarterly EPS compared to the same period ayear earlier.
95 QEPSGr Current growth. Compare thiswith thelast 1 or 3 year growth to deter-
mine consistency.
Quarterly revenue growth. Growth of quarterly revenues compared to the
96 QRev Gr same period ayear earlier. Current growth rate. Compare this with the
last 1 or 3 year growth to determine consistency.
Cash / current liabilities. Measure of liquidity which excludes recei-
97 Quick Ratio vables: ratio of 1 or higher is good. Some industries which deal in cash
typically have lower ratios.
Relative value. Formula: Current PE / Avg PE . An indication of value
% Rel Value based on past PE valuation.
Revenue consistency. R? (or R squared) is the coefficient of correlation
929 Rev R2 10Yr from the calculation of 'Hist 10Yr Rev Gr' . Variesfrom 1 to O where 1 is
the most consistent and desirable.
100 | RevR23Yr Revenue consistency over the last 3 years.
101 | RevR25Yr Revenue consistency over the last 5 years.
102 | RevRank - DB Compares short term growth to the average short term growth of the da-
tabase.
103 | Rev Rank - Indus Cor_npares short term revenue growth to the average short term growth of
the industry.
104 | Rev Trend le_ference in % revenue change of last 4 quarters growth and the
weighted growth for the company.
105 | Rev Trend - DB Compares '‘Rev Trend' of the company to the trends of the database.
106 | Rev Trend - Indus Compares 'Rev Trend' of the company to the trends of the industry.
. Numerica figure derived from "Trend ROE' . The numerical equivalent
107 | ROE Reting of "'Trend ROE', which varies from 6 to 0, where ++ =6 and -- = 0.
Numerical value for company’s quality rating. Betterlnvesting datafiles
use the S& P Quality Rating, which variesfrom 8 to 0, with 8 being the
108 | Quality Rating best. StockCentral datafiles use the Take Stock Quality Rating, which
varies from 0 to 10, with 10 being the best, with 3.4 or better considered
“acceptable,” and 6.7 or better considered “desirable.”
Latest sales figure from OPS data. Indication of the company size by
109 | Sdles
sales (revenue).
Highest third of the price range based on equal (33/33/33%) divisions
110 | Sell Above between Proxy Hi Pr and Proxy Low Pr .
Standard Industrial Classification number. A four-digit code: first 2 indi-
111 | SICNo cate industry group, second 2 indicate specific industry. As'Industry’ ex-
cept that it deals with a code.
112 | Symbol Trading symbol.
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113

Tax Rate

Average 5 year tax rate. Assess government’s effect on profits.

114

Tota Return

Compounded (annualized) total return that includes price appreciation
and portion contributed from dividends.

115

Trend Debt / Equity

Trend of debt to equity. Derived by reviewing the last 2 years figuresvs.
the 5-year average. Item 2C in the SA+ SSG. Indicators are ++, +, -+,
Even, +-, -, --, where + indicates an increase in debt to equity.

116

Trend PTI

Trend of pre-tax income on sales. Derived by reviewing the last 2 years
PTI figures vs. the 5-year average. Profitability will vary for each indus-
try. Item 2A in the SSG. Best to worst indicators are ++, +, -+, Even, +-,

117

Trend ROE

Trend of return on common equity. Derived by reviewing the last 2
years ROE figures vs. the 5-year average. How well does management
use assets (equity)? Item 2B in the SSG. Best to worst indicators are ++,
+, -+, Even, +-, -, --.

118

U/D Ratio

The ratio between the 'Current Price’ and the 'Proxy Hi Pr' .

Thefollowing lists detail the various Report Item Groups (1G) in Stock Prospector. The
order of items matches the order listed in Stock Prospector. The numbers to the left of the
item name match those in the Alphabetical Sort on the previous pages.

Other Items

22

Company Name

Company name.

112 Symbol Trading symbol.
47 Exchange Trading exchange.
Thisisindustry name. To screen by this use [Industry] = and select name
62 Industry fromthelist provided.
Standard Industrial Classification number. A four-digit code: first 2 indi-
111 SIC No cate industry group, second 2 indicate specific industry. As'Industry’ ex-
cept that it deals with a code.
30 Date Info Date when OPS data was generated.
70 Last Quarter Date Date of the last reported quarter in the OPS data.
82 Price Last Up- Typically the date of the last share price update, ‘Current Price' , or when
dated OPS data was first generated.
26 Current Price Current share price for the date indicated in 'Date Info'.
52W Hi Price Highest share price reached during the last 52 weeks.
52W Low Price Lowest share price during the past 52 weeks.
29 Currency Name D_efl ned when importing OPS data. Applicable only for dealing with for-
eign stocks.
8 Exchange Rate D_efl ned when importing OPS data. Applicable only for dealing with for-
eign stocks.
67 Last Full Yr Ia:tsat-year of data, the fiscal year. Thisisthe year of the last full year of
72 Num Yrs of Data Number of years of sales data available for the company.
24 Current EPS Current earnings per share — Total of last 4 quarters of reported earnings.
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23 Current Div Current dividend.

63 Inside Ownership Percent ownership by directors and management of the company.

64 Ingtitutional Percent ownership by pension and mutual funds and professional manag-
Holdings ers.

Growth Items

Growth items are calculated from data using a least squares regression formula based on
alogarithmic function. This method is used because it most closely defines the com-
pounded growth typical of growing companies.

The limitation of this calculation occurs for companies that have unusual data, i.e. nega-
tive EPSin one or more years. In these situations the growth calculation can provide mis-
leading answers. To ensure a proper growth figure, check the corresponding R2 (see
Quality Group items).

Where insufficient data exists to calculate an historical growth figure no data will be cal-
culated. For example, company with only 3 years of datawill not have 5 or 10 year
growth figures)

51

Hist 10Yr Rev Gr

Historical 10-year growth for revenues — Calculation uses the yearly data
and a least-squares calculation to determine past growth. Long term
growth rate. Use 'Rev R2 10Yr' to indicate consistency in results.

60

Hist 5Yr Rev Gr

Historical 5-year revenue growth. Use with 'Hist 10Yr Rev Gr' to indi-
cate trend of growth (increasing or decreasing). May also be used with
'Rev R2 5Yr' to indicate consistency in results.

57

Hist 3Yr Rev Gr

Historical 3-year revenue growth. Use with Items 'Hist 10Yr Rev Gr',
'Hist 5Yr Rev Gr', and 'Hist 1Yr Rev Gr' to indicate trend of growth (in-
creasing or decreasing). May also be used with 'Rev R2 3Y'r' to indicate
consistency in results.

Hist 1Yr Rev Gr

Historical 1-year revenue growth. Use with Items 'Hist 10Yr Rev Gr',
'Hist 5Yr Rev Gr', and 'Hist 3Yr Rev Gr' to indicate trend of growth (in-
creasing or decreasing).

69

Last 4Q Rev Gr

Latest 4 quarters revenue growth. Growth of moving 4 quarter revenues
compared to the similar period ayear earlier. Current growth rate. Com-
pare thiswith the last 1 or 3 year growth to determine consistency.

96

Q Rev Gr

Quarterly revenue growth. Growth of quarterly revenues compared to the
same period ayear earlier. Current growth rate. Compare this with the
last 1 or 3 year growth to determine consistency.

50

Hist 10Yr EPS
Gr

Historical 10-year growth for EPS. Uses aleast-squares calculation to
determine EPS growth. Long term growth rate. Use 'EPS R2 10yr' to in-
dicate consistency in results.

58

Hist 5Yr EPS Gr

Historical 5-year growth for EPS. As provided in OPS data. Use with
'Hist 10Yr EPS Gr' to indicate trend of growth (increasing or decreasing).
May also be used with 'EPS R2 5Yr' to indicate consistency in results.

55

Hist 3Yr EPS Gr

Historical 3-year EPS growth. Use with 'Hist 10Yr EPS Gr' and 'Hist 5Yr
EPS Gr' to indicate trend of growth (increasing or decreasing). May also
be used with 'EPS R2 3Yr' to indicate consistency in resullts.

52

Hist 1Yr EPS Gr

Historical 1-year EPS growth. Use with 'Hist 10Yr EPS Gr', 'Hist 5Yr
EPS Gr' and 'Hist 3Yr EPS Gr' to indicate trend of growth (increasing or
decreasing).
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68

Last 4Q EPS Gr

Latest 4 quarters EPS growth. Growth of moving yearly EPS compared
to the same period a year earlier. Current growth rate. Compare this with
thelast 1 or 3 year growth to determine consistency.

95

QEPSGr

Growth of quarterly EPS compared to the same period ayear earlier.
Current growth. Compare this with the last 1 or 3 year growth to deter-
mine consistency.

59

Hist 5Yr Price Gr

Price growth based on Monthly data.

56

Hist 3Yr Price Gr

Price growth based on Monthly data.

53

Hist 1Yr Price Gr

Price growth based on Monthly data.

Div Gr

Growth in dividends for the number of years of data available. For those
interested in income from investments.

16

Book Vaue Gr

Book value per share growth (common equity / number of shares).
Growth in book value for the number of years available. Regulated in-
dustries (utilities) pay out afixed amount based on their assets. Book
Vaueisan indication of assets.

19

Cash Flow Gr

Growth in cash flow for number of years of data available. Can be used
to confirm EPS growth. In some industries (resources, cable, etc.) cash
flow is a better indicator than EPS.

61

Implied Gr

Formula: Avg 5Yr ROE * (1 — Div Payout) . The growth rate of retained
earnings. An indication of future growth can be made from implied
growth.

49

Hist Share Gr

Growth in average share price for the number of years available, based
on yearly data. Comparing this to EPS growth, can suggest whether PE is
expanding or contracting. This can indicate whether a stock is getting
overpriced.

Value ltems

Vaueisdictated by the current price of the stock. Stock prices can vary substantially
over relatively short periods of time. Stock price affects 29 items in the Stock Prospector
database.

11

Avg 5Yr Low PE

Average low PE for last 5 years. Calculated from yearly information
from OPS data.

10 Avg 5Yr High Average high PE for last 5 years. Calculated from yearly information
PE from OPS data.
9 Ava PE Formula: (Avg 5Yr High PE + Avg 5Yr low PE) / 2. Average
9 Price/Earnings ration for the last 5 years.
o5 Current PE Current Price/Earnings ratio as available from OPS data. EPS (earnings)
isusualy for 2 reported quarters plus 2 anticipated quarters.

. Current PE divided by Historical EPS growth. As provided in OPS data

£ PE/Hist EPS Gr or isequal to: Current PE / Hist 10Yr EPS Gr - (Peter Lynch’s formula).
. Similar to 'PE / Hist EPS Gr' but using projected EPS. Commonly re-

6 PE / Proj EPS Gr ferred to as the PEG Ratio.
98 Rel Value Relative value. Formula: Current PE / Avg PE . An indication of value

based on past PE valuation.
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Compares current price to 52 week low price. Formula: Current Price -

0,
2 fo\l,:\,rom 52w 52W Low Price) / 52W Low Price (Will always be <= 0). Price being
near the 52 week low suggests a negative trend.
Compares current price to 52 week high price. Formula: Current Price -
. 52W Hi Price) / 52W Hi Price (Will always be <= 0). Price being close
0,
1 6 From S2W Hi to the 52 week high suggests a positive trend. This may show the compa-
ny to be overpriced.
Current price divided by the latest sales per share figure. An indication of
79 Price/ Sales value for fast growing companies - not susceptible to accounting methods
(EPS) and depreciation (BookV1).
. Price to cash flow per share. Current price divided by the latest reported
78 | Price/CashFlow | 0w figure. Review with ‘Cash Flow Gr' .
77 Price / Book Current price divided by latest reported book value (per share). Review
Vaue with '‘Book Vaue Gr'.
Price of Profitability. Formula: Current PE / Avg 5Yr ROE . Valuesless
4 PE/ Avg ROE than 1 indicate good value.
20 CashFlow / Share Cash flow per share. As provided by OPS data.
28 Cur Div Yidd Current dividend yield. For those interested in income from their invest-
ment.
Sy Historical average dividend yield. Calculated using the last 5 years' an-
14 AvgDiv Yidd nual datafrom OPS data.
113 Tax Rate Average 5 year tax rate. Assess government’s effect on profits.
The number of years for yearly accumulated EPS to equal current price.
73 Payback Generally between 6 and 10 - the lower the better. However, be suspi-

cious of very low numbers.

Quality Items

Revenue consistency. R? (or R squared) is the coefficient of correlation

99 Rev R2 10YTr from the calculation of 'Hist 10Yr Rev Gr' . Variesfrom 1to Owhere 1 is
the most consistent and desirable.
101 Rev R2 5Yr Revenue consistency over the last 5 years.
100 Rev R2 3Yr Revenue consistency over the last 3 years.
EPS consistency. R? (or R squared) is the coefficient of correlation from
39 EPS R2 10yr the calculation of 'Hist 10Yr EPS Gr' . Variesfrom 1 to O where 1 isthe
most consistent and desirable.
41 EPS R2 5yr EPS consistency over thelast 5 years.
40 EPS R2 3yr EPS consistency over the last 3 years.
36 1D(')\¢ ;jend R2 Dividend consistency over the last 10 years.
21 (fg\r(nr Equity R2 Common equity consistency over the last 10 years.
Average 5-year ROE. Simple average calculated from OPS data. Return
13 Avg 5Yr ROE on Common Equity. See 'Trend ROE' .
Average 5-year PTI. Simple average cal culated from OPS data. Pre-tax
12 Avg 5Yr PTI Income on Sales (i.e. profitability). See Trend PTI'" .
Trend of return on common equity. Derived by reviewing the last 2
117 Trend ROE years ROE figures vs. the 5-year average. How well does management

use assets (equity)? Item 2B in the SSG. Best to worst indicators are ++,
+, -+, Even, +-, -, -,
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Trend of pre-tax income on sales. Derived by reviewing the last 2 years
PTI figures vs. the 5-year average. Profitability will vary for each indus-

116 Trend PTI try. Item 2A in the SSG. Best to worst indicators are ++, +, -+, Even, +-,
. Numerica figure derived from "Trend ROE' . The numerical equivalent
107 ROE Rating of 'Trend ROE' , which variesfrom 6 to O, where ++ =6 and -- = 0.
o PTI Ratin Numerica figure derived from "Trend PTI' . The numerical equivalent of
9 ‘Trend PTI' , which varies from 6 to O, where ++ =6 and -- = 0.
66 Lré\r/entory Turno- Based on yearly sales and the latest inventory.
Safety Items
109 Sales Latest sales figure from OPS data. Indication of the company size by
sales (revenue).
7 Assets - Millions Current assets. Indicates company size by measuring its assets.
18 Captlztion - Mil- Capitalization = Number of shares* current price. Indication of the com-
lions pany size by market valuation.
71 I'\|l gnghareﬁ - Mil- Number of shares. Measure of possible liquidity of company.
. Standard & Poor’ s rating from OPS data. Numerica value for S&P's
108 S&PRating Quiality rating. Varies from 8 to 0, 8 being the best.
Dividend payout ratio. 5 yr average of ratio for dividends/ EPS. An indi-
35 Div Payout cator of safety of dividends paid. For most industries look for 60% or
less. Exceptions are utilities.
3 Debt / Equity pebt tq equity ratlo. Measure Of.|(.)l.’lg term debt for company. For most
industries 30% is acceptable. Utilities typically have high ratios.
8 gvg Debt / Equi- Average debt to equity over the last 5 years.
31 Debt / Capital As'Debt / Equity', except using the working capital .
Debt / Equit Numerical figure derived from trend of 'Debt / Equity' . The numerical
33 Ratin quity equivalent of 'Debt / Equity' , which varies from 6 to 0, where ++ = 6 and
9 -- = 0. For thisrating, 4 or lower is best.
Trend Debt / Ed- Trend of debt to equity. Derived by reviewing the last 2 years' figuresvs.
115 Lit a the 5-year average. Item 2C in the SA+ SSG. Indicators are ++, +, -+,
y Even, +-, -, --, where + indicates an increase in debt to equity.
Measure of price volatility in relation to the market. Could be misleading
15 Beta - :
for fast-growing companies.
65 Int Coverage Inter_eﬂ coverage. Th(_e ratio of pre-tax income to interest paid on all debt.
A ratio of 3 or larger is good.
o7 Current Ratio C_:urrent ratio. Current assets/ current liabilities. Measure of liquidity. Ra-
tios of 2 or higher are generally considered good.
Cash / current liabilities. Measure of liquidity which excludes recei-
97 Quick Ratio vables: ratio of 1 or higher is good. Some industries which deal in cash
typically have lower ratios.
88 Price Variance Statistical variation of yearly prices over the past 10 years.
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Projection Items

Projection items are flagged to help the user determine the source of the data. Potentially,
if the earnings growth is based on calculations, the figures could be misleading. Review
both the appropriate growth and R2 items when using projected items.

90 (F;rrOJ LYrEPS Projected EPS growth rate calculated from *1Yr Proj EPS' .
o1 Proj 5 Yr EPS Projected EPS growth rate expected over the next 5 years. See ‘5Yr Proj
Gr EPS.
5 1Yr Proj EPS Estimated EPS for current fiscal year EPS. See 'Proj 1 Yr EPS Gr'.
Estimated EPS extrapolated to calculate EPS 5 yearsin the future. For-
6 5Yr Proj EPS mula: 1Yr Proj EPS* (1+ Proj 5 Yr EPS Gr) A 4. See'Proj 5 Yr EPS
Gr'.
89 Proj EPS Revi- Calculated only during updates from data. This compares previous 1Yr
sion Proj EPS' to the current value and reports any changes.
37 EPS Est Flag If True, it indicatesthat ‘1Yr Proj EPS was provided from the data pro-
1Yr vider. If False, it was calculated by Prospector based on internal formula.
EPS E<t Fi If True, it indicates that 'Proj 5 Yr EPS Gr' was provided from the data
38 5Yr ag provider. If False, it was calculated by Prospector based on internal for-

mula.

Proxy for Judgment Items

The user is cautioned that proxy items are calculated from formulas and that they are not
to be construed as substitutes for appropriate judgment based on knowledge of the com-
pany. Normally, judgment is applied based on persona interpretation of datathat vali-
dates proxy items. No such validation is made or implied within Prospector.

92 Proxy Hi Pr Expected high price 5 yearsin the future.
Projected low price over the next 5 years based on a statistical assess-
93 Proxy Low Pr - S .
ment of price variation over the previous 5 years.
Lowest third of the price range based on equal (33/33/33%) divisions
o Buy Below between Proxy Hi Pr and Proxy Low Pr.
Highest third of the price range based on equal (33/33/33%) divisions
110 Sdll Above between Proxy Hi Pr and Proxy Low Pr .
81 Pricein Zone The % that the 'Current Price' is above the 'Proxy Low Pr' . Zero is at the
'Proxy Low Pr.” 100% is at the 'Proxy Hi Pr.’
80 Price App 'Compounded, (annualized) appreciation from ‘Current Price' to the
Proxy Hi Pr.
118 U/D Ratio The ratio between the 'Current Price' and the 'Proxy Hi Pr'.
114 Total Return Compounded (annualized) total return that includes price appreciation

and portion contributed from dividends.
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Trend and Rank Items

As with Growth Group items, Rank Items use growth calculation. As aresult you are
cautioned to assess Trends along with the corresponding R2 items in the Quality Group.

104 Rev Trend D|ffereiwce in % revenue change of last 4 quarters growth and the
weighted growth for the company.
106 Rev Trend - Indus Compares 'Rev Trend' of the company to the trends of the industry.
105 Rev Trend - DB Compares '‘Rev Trend' of the company to the trends of the database.
103 Rev Rank - Indus Compar% short term revenue growth to the average short term growth of
the industry.
102 Rev Rank - DB Compares short term growth to the average short term growth of the da-
tabase.
a4 EPS Trend Difference in % change EPS (last 4 quarters) to weighted growth for the
company.
46 555 Trend —In- Compares 'EPS Trend' of the company to the trends of the industry.
45 EPS Trend — DB Compares 'EPS Trend' of the company to the trends of the database.
3 EPS Rank - Indus pompar& short term EPS growth to the average short term growth of the
industry.
42 EPS Rark - DB Compares short term growth to the average short term growth of the da-
tabase.
85 Price Trend Difference in % price change (last 12 months) in comparison to the 5
year change.
87 g&'sce Trend - In- Compares 'Price Trend' of the company to the trends of the industry.
86 Price Trend - DB Compares 'Price Trend' of the company to the trends of the database.
84 Price Rank - In- Compares short term price changes to the average short term changes of
dus the industry.
83 Price Rank - DB Compares short term changes to the average short term changes of the
database.
Operators
A search criteriais an expression using operators (such as < or >) and values (text or
numbers).

The following operators can be used to define new expressions. Please be aware that this
information is provided as a preliminary reference only and is presented here merely to
indicate the variety of operators available. Thelist is not intended to be complete. Addi-
tional operators are available but not listed below.

This section is also not intended to be a lesson on using operators or building expressions.
Usersinterested in learning more about SQL (Structured Query Language) can refer to
the many books available on this subject. Specifically, we suggest books that reference
Microsoft Access database SQL .
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Logical Operators

Logical operators are normally set in the 'and/or' column when pro-mode is set. These
operators can aso be set within a criteria statement.

Operator Example

AND! Logical operators have seemingly strange operationsto be-

OR ginners. It is not the objective of this manual to explain
Boolean operations.

AND NOT

OR NOT

Comparative Operators

Operator Example

Greater Than > [Hist5Yr EPS Gr] > .15
Less Than < [Rel Value] < 1.0

Equa = [Exchange] = "NY SE*
Greater Than or [PTI Rating] >=4
Equa >=

Less Than or Equal [Date Info] <= #12/31/97#
<=

Not Equal <> 211F([Cur Price] <> 0, [Cur Div]/[Cur Price], 0)

Quotes"" and the number symbol # are used to indicate text and date information as
shown in the above examples.

Mathematical Operators

Operator Example

Addition + [Price App] + [Avg Div Yield]
Subtraction - [Sell Above] - [Cur Price]

Multiplication * [Rel Value] * 1.1 (relative value X 110%)
Division/ 3 [Cur Div] / [Cur Price]

Exponentia » [Cur EPS] * (1 + Proj 5YrEPS Gr) 5

Text and Other Operators

Operator Example

Like 4l Company Name] like"*ADR"
In [Symbol] in ('T",'ALD', 'AA")
Between [Rel Value] between .8 and 1.2

! The AND operator is used between statements if noneis specified.

2 Division by 0 (zero) isan illegal operation. Test for this possibility with the || F (immediate if) command
prior to performing the division.

3 Division by 0 (zero) isan illegal operation. Test for this possibility with the || F (immediate if) command
prior to performing the division.

4 The asterisk (*) wild card character is used to denote any number of characters preceding "ADR" This

statement finds all companiesthat are ADRs. ADR stands for American depositary receipts and represent
foreign shares traded on American exchanges.
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